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Paper Set 1 · 10 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant

The surface area of a cuboid is 12,600 ft2. If the cuboid’s length and
height are 60 ft and 30 ft, find the width of the cuboid (in ft).

A.  B. 40

B.  C. 50

C.  D. 45

D.  A. 55

✓

Q2 Quant
Two trains, 210 m and 230 m long respectively, are running on
parallel tracks in opposite directions. The faster train runs at 108
km/hr, while the slower train runs at 90 km/hr. How long will it take
for the two trains to completely cross each other? How much time
will the trains take to cross each other if they run in the same
direction?

A.  A. 5 seconds, 55 seconds

B.  C. 6 seconds, 66 seconds

C.  D. 8 seconds, 88 seconds

D.  B. 9 seconds, 99 seconds

✓

Q3 Quant
A store offers a scheme “Buy 3 and get 1 free” on soap bars. What is
the effective discount percentage under the scheme?

A.  B. 22%

B.  A. 24%

C.  C. 25%

D.  D. 28%

✓

Q4 Quant
A train travels 120 km at 55 km/h and returns at 45 km/h. What is its
average speed for the whole journey?

A.  A. 49.5 km/h

B.  B. 50.5 km/h

C.  C. 51.5 km/h

D.  D. 48.5 km/h

✓

Q5 Quant
Find the median of the given set of numbers: {21.2, 23.6, 27.5, 29.1,
21.6, 22.2, 23.5, and 22.1}

A.  C. 22.75

B.  D. 22.85

C.  B. 22.95

D.  A. 23.05

✓

Q6 Quant
Three partners, P, Q and R, agree to share the profits in the ratio of 2
: 3 : 5. After one year, the total profit is ₹1,80,000. What is R’s share
of the profit?

A.  C. ₹80,000

B.  D. ₹90,000

C.  A. ₹75,000

D.  B. ₹88,000

✓

Q7 Quant
A charitable organisation is distributing food packets to families
affected by a recent flood. The number of packets each volunteer
can prepare is inversely proportional to the number of hours they
work per day. Suppose 8 volunteers working 6 hours a day can
prepare a total of 960 packets. Then, how many volunteers would be
needed to prepare 1440 packets if they each work 4 hours a day,
given that the total number of working hours available per day for
all volunteers combined cannot exceed 120 hours?

A.  A. 16 volunteers

B.  D. 17 volunteers

C.  C. 18 volunteers

D.  B. 19 volunteers

✓

Q8 Quant
If 20% of a number is added to 48, then the result is the same
number. 80% of the same number is:329

A.  B. 48

B.  A. 58

C.  C. 78

D.  D. 68
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✓

Q9 Quant
A and B working together can do a piece of work in 6 days. B alone
can do the same work in 9 days. How long (in days) will A alone take
to do thrice the work?2559

A.  B. 54

B.  D. 108

C.  A. 162

D.  C. 216

✓

Q10 Quant
Mahesh has ₹1,300 with him. He divided it amongst his sons Vijay
and Ajay and asked them to invest it at 8% rate of interest
compounded annually. It was seen that Vijay and Ajay got same
amount after 19 and 20, years respectively. How much money (in ₹)
did Mahesh give to Ajay?10080

A.  A. 625

B.  D. 675

C.  C. 475

D.  B. 775

✓

Q11 Quant

The internal surface area (in m2) of an open cuboidal tank whose
internal length, internal breadth, and internal height are given as 46
m, 36 m, and 20 m, respectively, is:2677

A.  B. 4936

B.  A. 4888

C.  D. 4920

D.  C. 4894

✓

Q12 Quant
In what time (in months) will ₹3,000 fetch an interest of ₹420 at 7%
per year simple interest?

A.  24

B.  21

C.  22

D.  28

✓

Q13 Quant
A trader gains 25% by selling an article after allowing two successive
discounts of 20% and 25% on its marked price. If the cost price of
the article is increased by 60%, what single discount should he allow
now on the same marked price to obtain the same profit percentage
as before?

A.  C. 4%

B.  D. 2%

C.  B. 3%

D.  A. 5%

✓

Q14 Quant
The product of two consecutive positive integers is 182. If the
smaller of these two integers is represented by x, which of the
options below will correspond to the equation for finding out the
value of x?

A.  A. x2 + x - 182 = 0

B.  D. x2 + x + 182 = 0

C.  C. x2 - x - 182 = 0

D.  B. x2 - x + 182 = 0

✓

Q15 Quant

A.  B. 10 days

B.  D. 12 days

C.  C. 14 days

D.  A. 16 days

✓

Q16 Quant

A.  B. 1.82

B.  D. 18.2

C.  A. 0.182

D.  C. 0.0182
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✓

Q17 Quant

A.  A. 11

B.  D. 8

C.  B. 5

D.  C. 9

✓

Q18 Quant
6.222... + 6.333... in fraction form is:

A.  

B.  

C.  

D.  

✓

Q19 Quant

A.  B. 174

B.  D. 169

C.  C. 183

D.  A. 176

✓

Q20 Quant

A.  D. 400 mg

B.  A. 380 mg

C.  C. 350 mg

D.  B. 340 mg
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GA

✓

Q21 GA
Who among the following partnered with Indian tennis player
Ankita Raina to win the doubles title at the International Tennis
Federation Women’s Tournament in Guimaraes, Portugal, in June
2025?

A.  B. Sania Mirza

B.  A. Alice Robbe

C.  C. Rutuja Bhosale

D.  D. Kristina Mladenovic

✓

Q22 GA
Which of the following rivers is the second largest in Odisha?

A.  A. Mahanadi

B.  D. Brahmani

C.  C. Subarnarekha

D.  B. Baitarani

✓

Q23 GA
Which of the following national leaders was referred to as
'Deshbandhu'?

A.  D. Motilal Nehru

B.  A. Chittaranjan Das

C.  C. Lala Lajpat Rai

D.  B. Gopal Krishna Gokhale

✓

Q24 GA
Which railway station in Madhya Pradesh’s Guna district was
honoured with the National Energy Conservation Award (NECA)
2025 for its exemplary performance in energy efficiency and
sustainable operations?

A.  A. Miyana Railway Station

B.  C. Ruthiyai Railway Station

C.  D. Chagancherry Railway Station

D.  B. Kottyam Railway Station

✓

Q25 GA
In August 2025, Shibu Soren, who passed away at the age of 81, had
previously served as the Chief Minister of which Indian state?

A.  B. Jharkhand

B.  A. Odisha

C.  C. Andhra Pradesh

D.  D. Manipur

✓

Q26 GA
Which statement correctly describes the behavior of onion as an
olfactory indicator?

A.  B. Onion smell remains in both acidic and basic solutions

B.  D. Onion smell disappears in a basic solution but remains in
an acidic solution

C.  C. Onion smell disappears in both basic and acidic solution

D.  A. Onion smell disappears in an acidic solution but remains
in a basic solution

✓

Q27 GA
Which of the following is INCORRECTLY paired with its origin?

A.  C. Godavari – Trimbakeshwar

B.  A. Yamuna – Yamunotri

C.  B. Narmada – Amarkantak

D.  D. Krishna – Satpura hills

✓

Q28 GA
Which new major scheme did the Odisha Cabinet approve with an
outlay of approx ₹1,113.50 crore for 2025-30?

A.  D. Development of Biotechnology scheme

B.  B. State-Clean Air Programme

C.  A. Green Livelihoods Initiative

D.  C. Mukhyamantri Sahari Bikash Yojana

✓

Q29 GA
In July 2025, India successfully test-fired two strategic ballistic
missiles — Prithvi-II and Agni-I — from which place in Odisha?

A.  B. Abdul Kalam Island, Balasore

B.  C. Integrated Test Range (ITR), Chandipur

C.  A. Gopalpur, Ganjam

D.  D. Dhamra, Bhadrak

✓

Q30 GA
The famous silver filigree work of Odisha is known as?

A.  B. Ikat

B.  A. Tarakasi

C.  C. Pattachitra

D.  D. Dhokra
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Q31 GA
Where was the Hyogo Framework for Action (HFA) 2005–2015
adopted?

A.  A. Sendai, Japan

B.  D. Kobe, Japan

C.  C. Geneva, Switzerland

D.  B. New Delhi, India

✓

Q32 GA
Which country hosted the World Para Athletics Championships
2025?

A.  C. India

B.  B. China

C.  A. United Kingdom

D.  D. Australia

✓

Q33 GA
Which Act, also known as the Morley-Minto Reforms, introduced the
concept of separate electorates for Muslims in India?

A.  A. Government of India Act, 1919

B.  D. Indian Councils Act, 1909

C.  C. Government of India Act, 1935

D.  B. Charter Act, 1833

✓

Q34 GA
A company wants to produce healthy cooking oil. Which crop quality
should they focus on?

A.  A. Unsaturated fatty acid quality in seeds

B.  C. Improving the yield of seed coats

C.  D. Saturated fatty acid content in seeds

D.  B. Preserving quality of seeds

✓

Q35 GA
The Palk Strait separates India from which country?

A.  D. Maldives

B.  B. Sri Lanka

C.  C. Myanmar

D.  A. Indonesia

✓

Q36 GA
Which of the following water bodies separates the Andaman group
of islands from the Nicobar group of islands?

A.  B. Palk Strait water body

B.  C. Gulf of Mannar water body

C.  A. Ten Degree Channel water body

D.  D. Malacca Strait water body

✓

Q37 GA
Which of the following awards is given to honour eminent coaches
who have successfully trained sportspersons or teams and enabled
them to achieve outstanding results in international competitions?

A.  A. The Dronacharya Award

B.  D. The Arjuna Award

C.  C. The Padma Bhushan

D.  B. The Dhyan Chand Award

✓

Q38 GA
Which classical dance form characterised by a predominance of
lasya (graceful feminine movements) is traditionally performed by
women, and originated in Kerala?

A.  B. Sattriya

B.  A. Mohiniyattam

C.  C. Manipuri

D.  D. Kuchipudi

✓

Q39 GA
A moving object is brought to rest by applying brakes. Why is the
work done by the brakes considered negative?

A.  A. Brakes increase motion

B.  D. Brakes act in the direction of motion

C.  C. Brakes oppose motion

D.  B. Brakes have no force

✓

Q40 GA
Which organisation publishes the Human Development Report
(HDR) annually, including the Human Development Index (HDI)
rankings?

A.  A. International Monetary Fund (IMF)

B.  B. United Nations Development Programme (UNDP)

C.  C. World Bank

D.  D. World Economic Forum (WEF)
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English

✓

Q41 English
Select the option that can be used as a one-word substitute for the given group of words.

A government by a single person with absolute power

A.  D. Democracy

B.  B. Autocracy

C.  A. Bureaucracy

D.  C. Theocracy

✓

Q42 English
Choose the correct idiom to replace the underlined part of the following sentence.
I had to perform a series of tedious and difficult tasks just to get approval for the project.

A.  D. break the ice

B.  A. kill two birds with one stone

C.  C. jump through hoops

D.  B. bark up the wrong tree

✓

Q43 English
Complete the following direct sentence.
The chief engineer said, "____________."

A.  C. The flyover would be build in three years

B.  A. The flyover will being build in three years

C.  B. The flyover would built in three years

D.  D. The flyover will be built in three years

✓

Q44 English
The sentence has one misspelled word (shown in italics). Choose the option with the correct spelling to replace the italicized word and correct
the sentence.
The artist painted the sunset with great precission and care.

A.  D. precesion

B.  B. prescision

C.  A. precissionn

D.  C. precision

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q45 English

Choose the sentence that is correctly given in passive voice.

A. The chef is preparing a complicated new recipe.
B. A complicated new recipe is being prepared by the chef.
C. The restaurant owner will taste the dish soon.
D. Diners are enjoying the meal in the main hall.

A.  A. A

B.  B. B

C.  C. C

D.  D. D

✓

Q46 English
Choose the correct meaning of the underlined proverb.
He got a good grade on one test, but one swallow doesn't make a summer.

A.  B. One success ensures future achievements.

B.  D. One effort is enough for achieving all goals.

C.  A. One good result doesn’t mean lasting success.

D.  C. One mistake ruins every sincere attempt.

✓

Q47 English

Read the passage and answer the following questions.

In the fable 'The Monkey and the Crocodile', a clever monkey lives near a river and befriends a crocodile. The crocodile, tempted by the idea of
eating the monkey’s heart, invites him to his home. Sensing danger, the monkey uses his wit to save himself. When the crocodile tries to carry
him across the river, the monkey cleverly tricks the crocodile by saying he left his heart on the tree and needs to fetch it. The crocodile returns
him to safety, and the monkey escapes unharmed. The story highlights intelligence and quick thinking as tools for survival. It teaches that
cleverness can overcome physical strength and that one must be cautious of hidden motives, even from friends. Through lively storytelling, the
fable conveys lessons on trust, resourcefulness, and the importance of thinking before acting.

Where does the monkey live?

A.  A. In a cave

B.  C. Near a river

C.  D. In a forest tree alone

D.  B. On a mountain

✓

Q48 English
Why does the monkey trick the crocodile?

A.  D. To play a game

B.  C. To escape danger

C.  A. To make friends

D.  B. To teach a lesson

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q49 English
In this context, what does “wits” most nearly mean?

A.  A. Physical strength

B.  D. Anger and supression

C.  B. Cleverness or intelligence

D.  C. Laziness

✓

Q50 English
Which best describes the tone of the passage?

A.  B. Serious and instructive

B.  A. Sad and mournful

C.  C. Angry and harsh

D.  D. Playful and adventurous

✓

Q51 English
Which option best summarizes the passage?

A.  A. The monkey’s clever escape proves intelligence wins.

B.  C. The crocodile eats the monkey after tricking him.

C.  D. The monkey and crocodile live happily together forever.

D.  B. The monkey leaves the river to find another home.

✓

Q52 English
Choose the correct future form of the given sentence.
Catherine said, “By next year, we __________ this experiment for five years.”

A.  B. will conduct

B.  A. will be conducting

C.  D. will have been conducting

D.  C. will have conducted

✓

Q53 English
In the given question, a sentence divided into different segments has been given. Rearrange the segments to form a coherent sentence.
(P) because of the heavy rain (Q) was cancelled (R) the football match (S) scheduled for today

A.  D. R S Q P

B.  C. P Q R S

C.  A. Q R S P

D.  B. S P Q R

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q54 English
Identify the antonym of the highlighted word in the sentence.

The company’s frugal policies helped it survive the financial crisis.

A.  A. Extravagant

B.  D. Limited

C.  C. Cautious

D.  B. Efficient

✓

Q55 English
The parts of a sentence are given below. While the first part (S) is fixed and correctly placed, the remaining segments are jumbled. Rearrange
them to form a clear, meaningful, and grammatically correct sentence.

S. The Industrial Revolution
A. populations in many
B. changed production methods
C. European countries
D. and expanded urban

A.  C. ACBD

B.  D. BACD

C.  B. CABD

D.  A. BDAC

✓

Q56 English
Choose the most appropriate option to complete the sentence.

The instructions were explained ______, leaving the participants confused about the process.

A.  C. nervously

B.  A. efficiently

C.  B. awfully

D.  D. deliberately

✓

Q57 English
Select the option that can be used as a one-word substitute for the given group of words.

A person who is new to a subject or activity

A.  D. Expert

B.  B. Novice

C.  C. Veteran

D.  A. Specialist
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Q58 English
Select the most appropriate option to fill in the blank.

Despite his calm appearance, Ravi grew increasingly ______ as the deadline approached.

A.  C. anxious

B.  D. anxiousness

C.  B. anxiety

D.  A. anxiously

✓

Q59 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

Despite arriving with barely _____ ounce of preparation, Marianne navigated the interdisciplinary colloquium with such fluency that seasoned
scholars were momentarily disarmed.

A.  C. a

B.  A. an

C.  B. the

D.  D. No article required

✓

Q60 English
Select the most appropriate ANTONYM of the highlighted word in the following sentence.

The play performed by the students during teacher’s day revolved around a heart-breaking tragedy that left the teachers in tears.

A.  B. Drama

B.  D. Comedy

C.  C. Thriller

D.  A. Fiction
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Odisha has a rich tradition of poetry and storytelling.

A.  B. ଓଡ଼ି ଶାର କବି ତା ଏବଂ କାହାଣୀର ଏକ ସମୃ ଦ୍ଧ ଚଳଣି  ରହି ଅଛି ।

B.  D. ଓଡ଼ି ଶା କବି ତା ଓ କାହାଣୀ କହି ବା ଧନି ଶାଳୀ ପରମ୍ପରା ରହି ଛି ।

C.  C. ଓଡ଼ି ଶାରେ କବି ତା ଓ କାହାଣୀ କହି ବା ପରମ୍ପରା ଧନି ଶାଳୀ ରହି ଛି ।

D.  A. ଓଡ଼ି ଶାରେ କବି ତା ଓ କାହାଣୀ କହି ବା ଧନି  ପରମ୍ପରା ରହି ଛି ।

✓

Q62 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

କଠି ନ ପରି ଶ୍ର ମର କୌଣସି  ବି କଳ୍ପ ନାହିଁ।

A.  A. There is no substitute to hard work.

B.  C. There was no substitute to hard work.

C.  D. There has been no substitute to hard work.

D.  B. There had been no substitute to hard work.

✓

Q63 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।

ଆଧୁ ନି କ ସଭ୍ୟତାର ବି ପକ୍ଷବାଦୀମାନେ କହନ୍ତି  ଯେ, ଏହି  ସଭ୍ୟତା ମାନବର ଈଶ୍ୱରବି ଶ୍ଵାସ କମେଇ ଦେଇ ତାହାକୁ  ବି ପଥଗାମୀ କରି  ପକାଇଛି  । ସର୍ବ ତ୍ର  ସଂଯମର ଅଭାବ ପରି ଲକ୍ଷି ତ ହେଉଅଛି  ।
ମାନବ ମାନବ ପ୍ର ତି  ସ୍ନେହ ସୌହାର୍ଦ  ନ ଦେଖାଇ ହିଂ ସା ଦ୍ଵେଷର ଚରମ ସୋପାନ ଦେଖାଇବାକୁ  ଛାଡୁ  ନାହାନ୍ତି  । ବୈ ଜ୍ଞାନି କମାନେ ମାରାତ୍ମକ ଗ୍ୟାସ ଓ ବି ସ୍ଫୋରକର ଉଦ୍ଭାବନ କରି  ମାନବକୁ  ଧ୍ୱଂସ
ପଥର ପଥି କ କରୁ ଅଛନ୍ତି  । ଅବଶ୍ୟ ବି ଜ୍ଞାନର କେତେକ ଆଶ୍ଚର୍ଯ୍ୟ ଜନକ ପଦାର୍ଥ ବଳରେ ଧ୍ୱଂସ ସାଧି ତ ହେଉଅଛି , ମାତ୍ର  ତାହା ବି ଜ୍ଞାନର ଦୋଷ ନୁ ହେଁ  । ସାଧାରଣ ମାନବ ଯେତେବେଳେ ସଭ୍ୟତାର ଅର୍ଥ
ବୁ ଝି ବ, ସେତେବେଳେ ଯାଇ ଏହାର ଅବସାନ ହେବ । ବର୍ତ୍ତ ମାନ ଆମ୍ଭମାନଙ୍କବି ଜ୍ଞାନର ଚରମ ଉନ୍ନତି  ନ ହେବା ପର୍ଯ୍ୟ ନ୍ତ ଆମ୍ଭେମାନେ ସଭ୍ୟତା ବି ଷୟରେ ଶେଷ ଉନ୍ନତି ରେ ପହଞ୍ଚି  ପାରି ବୁ  ନାହିଁ ।
ସେହି  ଶେଷ ସୀମା ପର୍ଯ୍ୟ ନ୍ତ ଯେଉଁ  ବ୍ୟତି କ୍ର ମଗୁ ଡ଼ି କ ଦୃ ଷ୍ଟ ହେବ, ତାହା ସବୁ  କାଳରେ, ସବୁ  ଯୁ ଗରେ ହୋଇଥି ଲା ଏବଂ ହେବା ସମ୍ଭବ । ଯେତେବେଳେ ଆଧୁ ନି କ ସଭ୍ୟତାର ଆଦର୍ଶ  ପ୍ର ତ୍ୟେକେ
ଜାଣି ବେ, ସେତେବେଳେ ମୈ ତ୍ରୀ ର ଧ୍ଵଜା ଉଡ଼ି ବ । ବର୍ତ୍ତ ମାନ ଜାତି ସଂଘ ତାର ସୂ ତ୍ର ପାତ କରି ଛି  ମାତ୍ର  ବର୍ତ୍ତ ମାନ ଏହି  ସଂଘର କାର୍ଯ୍ୟ ପ୍ର ଣାଳୀ ସମସ୍ତେ ମାନୁ  ନାହାନ୍ତି , ତଥାପି  ଆଶା କରାଯାଏ ଯେ
ଭବି ଷ୍ୟତରେ ଯେତେବେଳେ ସମସ୍ତେ ନି ଜ ନି ଜ ପ୍ର ତି  କର୍ତ୍ତ ବ୍ୟ ବୁ ଝି  ପାରି ବେ, ସେତେବେଳେ ଏ ସବୁ  ଅନର୍ଥ  ଦୃ ଷ୍ଟି ଗୋଚର ହେବ ନାହିଁ । ବି ଜ୍ଞାନର ଏହି  ବି ସ୍ଫୋରକ ଓ ମାରାତ୍ମକ ଗ୍ୟାସ ବଳରେ
ଅଶେଷ କ୍ଷତି  ହେଉଥି ଲେ ହେଁ  ସେମାନଙ୍କ ବଳରେ ଅନେକ ବି ଶ୍ଵହି ତକର କାର୍ଯ୍ୟ  ସାଧି ତ ହେଉଅଛି  । ଡି ନାମାଏଟ୍  ନାମକ ବି ସ୍ଫୋରକ ସାହାଯ୍ୟରେ ତୁ ଙ୍ଗ ଗି ରି  ଫଟାଇ ନି ଜର ଈପ୍ ‌ସି ତ କାର୍ଯ୍ୟ
ଅକ୍ଳେଶରେ ସାଧନ କରାଯାଇ ପାରୁ ଛି  । ବି ଭି ନ୍ନ ସାମୟି କ ପଦାର୍ଥ  ବଳରେ ମାନବର ବି ଭି ନ୍ନ ରୋଗ ଓ ରୋଗର ଜୀବାଣୁ  ପ୍ର ଭୃ ତି  ନଷ୍ଟ କରାଯାଇ ପାରୁ ଛି  । ସେମାନଙ୍କର ଅପକାରି ତା ମାନବର ଜ୍ଞାନର
ଅଳ୍ପତା ଯୋଗୁ ହିଁ ସଂଘଟି ତ ହେଉଅଛି , ବି ଜ୍ଞାନ ବଳରେ ନୁ ହେଁ  । ବି ଜ୍ଞାନ କମାଇ ଦେଇଛି  ଧର୍ମ ଭାବ ଓ ଈଶ୍ୱରବି ଶ୍ୱାସ ବି ଜ୍ଞ ବୋଲି  ଅନେକେ ଅଭି ଯୋଗ କରି ଥାନ୍ତି  । ମାତ୍ର  ବାସ୍ତବରେ କ’ଣ ହୋଇଛି
ଦେଖାଯାଉ । ଯେଉଁ ମାନେ ଉଲ୍ଲି ଖି ତ ମତ ପୋଷଣ କରନ୍ତି , ସେମାନେ ପ୍ରା ଚୀନ ସଭ୍ୟତାକୁ  ନି ଜର ଆଦର୍ଶ  ବୋଲି  ଧରି  ନେଇ ନି ଶ୍ଚି ନ୍ତ ଅଛନ୍ତି  ଯେ, ଈଶ୍ଵର ବି ଦ୍ୟମାନ ଓ ତାଙ୍କଠାରେ ବି ଶ୍ୱାସ ସ୍ଥାପନ
କର୍ତ୍ତ ବ୍ୟ । ମାତ୍ର  ବର୍ତ୍ତ ମାନର ସଭ୍ୟତା ଗତି ପଥରେ ଅବସ୍ଥି ତ । ତାହା ଲାଭ କରି ବାକୁ  ଆମ୍ଭେମାନେ ଅତୀତ ଅଭି ଜ୍ଞତାର ସାହାଯ୍ୟ ନେଉଥାଇଁ , ମାତ୍ର  ଅତୀତ କଥାକୁ  ମାନି  ନେଇ ନଥାଇଁ , ଆମ୍ଭେମାନେ
ବି ଜ୍ଞାନ ବଳରେ ସେହି  ବି ରାଟ ଶକ୍ତି ର କଳନା କରି ବାକୁ  ଯାଉଥାଇଁ , ତେଣୁ  ପ୍ର ଥମେ ତାହାର ଉପସ୍ଥି ତି  କାହିଁକି  ବି ଶ୍ଵାସ କରି ନେବୁ  ?

ଅନୁ ଛେଦଟି ର ଶୀର୍ଷ କ ଚି ହ୍ନଟ କର ।

A.  C. ସାହି ତ୍ୟ ଓ ସମାଜ

B.  A. ଇତି ହାସ

C.  B. ସଭ୍ୟତା ଓ ବି ଜ୍ଞାନ

D.  D. ଭୌତି କ ବି ଜ୍ଞାନ

✓

Q64 Odia
ଅନୁ ଛେଦର ଗଢଣ ଚି ହ୍ନଟ କର ।

A.  A. ଐତି ହାସି କ

B.  B. ବୈ ଜ୍ଞାନି କ

C.  C. ରାଜନୈ ତି କ

D.  D. ସାମାଜି କ
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✓

Q65 Odia
ଯେଉଁ ମାନେ ଉଲ୍ଲି ଖି ତ ମତ ପୋଷଣ କରନ୍ତି , ସେମାନେ କେଉଁ  ସଭ୍ୟତାକୁ  ନି ଜର ଆଦର୍ଶ  ବୋଲି  ଧରି  ନେଇ ନି ଶ୍ଚି ନ୍ତ ଅଛନ୍ତି  ?

A.  B. ପ୍ରା ଚୀନ

B.  D. ଆଧୁ ନି କ

C.  A. ବୈ ଜ୍ଞାନି କ

D.  C. ସଂସ୍କୃତି  ଓ କଳା

✓

Q66 Odia
ଯେତେବେଳେ ଆଧୁ ନି କ ସଭ୍ୟତାର ଆଦର୍ଶ  ପ୍ର ତ୍ୟେକେ ଜାଣି ବେ, ସେତେବେଳେ କାହାର ଧ୍ଵଜା ଉଡ଼ି ବ ?

A.  B. ସତ୍ୟର

B.  D. ମୈ ତ୍ରୀ ର

C.  A. ଦେଶର

D.  C. କଳାର

✓

Q67 Odia
କେଉଁ  ନାମକ ବି ସ୍ଫୋରକ ସାହାଯ୍ୟରେ ତୁ ଙ୍ଗ ଗି ରି  ଫଟାଇ ସାଧନ ନି ଜର ଈପ୍ ‌ସି ତ କାର୍ଯ୍ୟ  ଅକ୍ଳେଶରେ ସାଧନ କରାଯାଇ ପାରୁ ଛି  ?

A.  B. ଏନ୍  ଟି  ଏନ୍

B.  C. ପି ଇଟି ଏନ୍

C.  D. ନାଇଟ୍ରୋ ଜେନ୍

D.  A. ଡି ନାମାଏଟ୍

✓

Q68 Odia
ପି ଳେହି  ପାଣି  ହେବା । ଏହି  ଋଢି ର ଅର୍ଥ  କ'ଣ ?

A.  A. ଆଶ୍ଚର୍ଯ୍ୟ  ହେବା

B.  D. ଅଧି କ ଖୁ ସି  ହେବା

C.  C. ରାଗି ଯି ବା

D.  B. ଭୟରେ ଛାନି ଆ ହେବା

✓

Q69 Odia
ଆମ ଗାଁ 'ରେ ଏକ ଇଟା ଦେଉଳ ଅଛି । ଏହି  ବାକ୍ୟରେ ଥି ବା ବି ଶେଷଣ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  D. ଆମ ଗାଁ 'ରେ

B.  B. ଇଟା

C.  A. ଦେଉଳ

D.  C. ଅଛି

✓

Q70 Odia
"ଉଦାର" ର ବି ପରୀତ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  B. ଦୟାଳୁ

B.  D. ଅନୁ ଦାର

C.  C. ଉଦାତ୍ତ

D.  A. ସହୃ ଦୟ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q71 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ ସ୍ଥାନବାଚକ କ୍ରି  ୟା ବି ଶେଷଣର ଉଦାହରଣ?

A.  A. ଶୀଘ୍ର

B.  B. ବହୁ ତ

C.  C. ସର୍ବ ତ୍ର

D.  D. ହଠାତ୍

✓

Q72 Odia
ମୁଁ  ବହି ଟି କୁ  ଭଲ ଭାବରେ ପଢ଼ି ଛି  I
-ଏହି  ଓଡି ଆ ବାକ୍ୟଟି ର ଇଂରାଜୀ ଅନୁ ବାଦଟି  ଲେଖ ।

A.  B. I have gone through from this book.

B.  C. I have been gone through this book.

C.  D. I have gone through this book.

D.  A. I have gone through with this book

✓

Q73 Odia
ନି ମ୍ନୋ କ୍ତ ବାକ୍ୟଗୁ ଡି କ ମଧ୍ୟରୁ  ଶୁ ଦ୍ଧ ବାକ୍ୟଟି କୁ  ଚି ହ୍ନଟ କର।

A.  A. ଚାଷି  ଦାଆରେ ଧାନ କାଟୂ ଛି  ।

B.  C. ଚାଷୀ ଦାଆରେ ଧନ କାଟୁ ଛି  ।

C.  D. ଚାଷୀ ଦାଆରେ ଧାନ କାଟୁ ଛି  ।

D.  B. ଚାସୀ ଦାଆରେ ଧାନ କାଟୁ ଛି  ।

✓

Q74 Odia
ଧାତୁ  ପରେ ଯେଉଁ  ପ୍ର ତ୍ୟୟ ଯୁ କ୍ତ ହୋଇ କ୍ରି  ୟାପଦ ଗଠି ତ ହୁ ଏ, ତାକୁ  କଣ କୁ ହାଯାଏ?

A.  B. କୃ ତ୍  ପ୍ର ତ୍ୟୟ

B.  C. ତଦ୍ଧି ତ ପ୍ର ତ୍ୟୟ

C.  D. କ୍ରି  ୟା ବି ଭକ୍ତି

D.  A. ବି ଶେଷଣ

✓

Q75 Odia
"ଧରାକୁ  ସରା ମଣି ବା"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କି ଏ ?

A.  C. ଅସାଧାରଣ ଜୀବନ ବି ତାଇବା

B.  A. ସମସ୍ତଙ୍କୁ  ସମ୍ମାନ କରି ବା

C.  D. ନମ୍ର ତା ରକ୍ଷା କରି ବା

D.  B. ଅତି  ଗର୍ବ ଭାବ ପ୍ର ଦର୍ଶ ନ କରି ବା
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Computer

✓

Q76 Computer
Which of the following is the most basic and common method used
to control who can initially connect to and access a secure network?

A.  A. Using a firewall to block all external traffic.

B.  D. Requiring a username and password to join the network.

C.  B. Installing antivirus software on every connected device.

D.  C. Encrypting all data packets sent across the network.

✓

Q77 Computer
In Microsoft Word, which feature allows you to apply a predefined
set of formatting options (such as font, color, and size) to selected
text with a single click?

A.  C. Style

B.  D. Review

C.  B. Editing

D.  A. Table Layout

✓

Q78 Computer
Which of the following fields in an email contains the title or
purpose of the message?

A.  B. Cc

B.  A. Bcc

C.  D. To

D.  C. Subject

✓

Q79 Computer
Which of the following methods allows you to view an MS
PowerPoint presentation in Slide Show mode from the beginning?

A.  C. Press F5

B.  A. Press Ctrl + P

C.  D. Go to View → Normal

D.  B. Press Ctrl + N

✓

Q80 Computer
Which tab in PowerPoint is used to insert audio or video clips into
a slide?

A.  D. Home

B.  C. Insert

C.  A. Design

D.  B. Review

✓

Q81 Computer
When you open a CSV file in Excel, which of the following happens
automatically?

A.  A. Excel applies all cell formatting from the source file.

B.  B. Excel prevents editing until converted to .xlsx.

C.  D. Excel separates values based on commas or delimiters.

D.  C. Excel merges all data into a single cell.

✓

Q82 Computer
Match the following Presentation Creation Options (Column A)
with their correct Descriptions (Column B) as used for Creating a
Blank Presentation in Microsoft PowerPoint 2016/2019:

Column A –
Option /

Command
Column B – Description

1. Ctrl + N
a) Opens a new blank presentation using the
default slide layout.

2. File → New →
Blank Presentation

b) Creates a new presentation manually
without applying a template or theme.

3. Start Screen →
Blank Presentation

c) Allows quick access to a blank presentation
directly from the PowerPoint start screen.

4. File → Close d) Closes the current presentation but keeps
PowerPoint open.

A.  C. 1–a, 2–b, 3–c, 4–d

B.  D. 1–b, 2–c, 3–a, 4–d

C.  A. 1–a, 2–d, 3–b, 4–c

D.  B. 1–d, 2–b, 3–a, 4–c

✓

Q83 Computer
Pressing ALT with which function key is used to close the current
application window in MS Windows 11?

A.  C. Alt + F4

B.  A. Alt + F2

C.  B. Alt + F1

D.  D. Alt + F7

✓

Q84 Computer
Which shortcut key is used to directly open Task Manager in
Windows 11?

A.  B. Ctrl + C

B.  C. Ctrl + Alt + Delete

C.  A. Ctrl + Shift + Esc

D.  D. Alt + Tab
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✓

Q85 Computer
What does ASCII stand for?

A.  C. Advanced System Code for Internet Interface

B.  A. Automatic Standard Code for Internal Integration

C.  B. American Standard Code for Information Interchange

D.  D. American Scientific Code for International Internet

✓

Q86 Computer
Which of the following options are applicable to STOP a bulleted or
numbered list?

i. At the end of the bulleted or numbered list, press RETURN two
times.
ii. Select the line of text that you do not want in the list, and then, on
the Home tab, in the Paragraph group, click Bulleted List or
Numbered list.
iii. On the Home tab, in the Paragraph group, click Increase Indent.
iv. Ctrl + click or right-click the item, and then click Restart
numbering.

A.  B. i and ii only

B.  C. i, ii, iii, and iv

C.  D. i, ii, and iii only

D.  A. ii, iii, and iv only

✓

Q87 Computer
What is the purpose of the IF function in MS Excel?

A.  A. To perform addition if a condition is true

B.  D. To calculate a sum based on a specific condition

C.  C. To apply a conditional test and return different values
based on the result

D.  B. To find the highest value in a range

✓

Q88 Computer
What is the purpose of Excel's TEXT function?

A.  D. To convert a numerical value into a text string with custom
formatting

B.  C. To combine text from multiple cells or strings into a single
cell

C.  B. To translate the text from one language to another

D.  A. To convert text to uppercase

✓

Q89 Computer
Which of the following keyboard shortcuts in MS Word 2021 is
accurately matched with its corresponding function for handling
reusable content and advanced text movement?

A.  C. Ctrl + F3 – Sends the selected content to a new AutoText
entry for later insertion

B.  A. Shift + F2 – Transfers the selected text to a different
position by relocating the cursor and pressing Enter

C.  B. Alt + F3 – Defines the selected text as a reusable AutoText
block

D.  D. F2 – Copies the selected content to the Clipboard, then
inserts it at the new location after pressing Enter

✓

Q90 Computer
Which of the following best describes a Local Area Network (LAN)?

A.  D. A network that connects computers across the globe

B.  C. A network used for satellite communication

C.  A. A network that connects computers within a limited area
like a home or school

D.  B. A mobile app for file sharing
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✓

Q91 Reasoning
In a certain code language,
'A + B' means ‘A is the father of B’,
'A – B' means ‘A is the brother of B’,
'A x B' means ‘A is the wife of B’,
'A ÷ B' means ‘A is the husband of B’.

How is A related to B if ‘A x Q + S – R ÷ B’?1965

A.  D. Husband’s sister

B.  A. Husband's father's sister

C.  B. Husband’s brother's wife

D.  C. Husband’s mother

✓

Q92 Reasoning
Seven people H, S, Y, V, B, M and A are sitting in a straight line,
facing the north. H is sitting to the immediate left of Y. Only two
people are sitting between A and H. B is sitting second to the left of
A. M is sitting to the immediate right of S. How many people are
sitting between B and H?2212

A.  A. One

B.  C. Two

C.  B. Three

D.  D. Four

✓

Q93 Reasoning
A, B, C, M, N and O live on six different floors of the same building.
The lowermost floor in the building is numbered 1, the floor above it
is numbered 2 and so on till the topmost floor is numbered 6. Only
two people live between N and B. Only O lives above M. C lives on an
even numbered floor. N lives on the lowermost floor. How many
people live between A and O?

A.  A. One

B.  D. Two

C.  C. Three

D.  B. Four

✓

Q94 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

ENH 28, GPK 41, IRN 54, KTQ 67, ?

A.  A. LVS 82

B.  B. NUT 82

C.  C. MVT 80

D.  D. LWU 80

✓

Q95 Reasoning
What will come in the place of the question mark (?) in the following
equation, if ‘+’ and ‘–’ are interchanged and ‘×’ and ‘÷’ are
interchanged?

28 ÷ 5 + 14 × 7 – 2 = ?

A.  C. 120

B.  A. 140

C.  D. 165

D.  B. 187

✓

Q96 Reasoning
ZE 10 is related to VH 26 in a certain way. In the same way, KI 17 is
related to GL 33. To which of the following is RP 29 related, following
the same logic?

A.  C. NS 45

B.  A. MJ 65

C.  B. KJ 56

D.  D. KJ 67

✓

Q97 Reasoning
In a certain code language, 'THANK' is coded as '44' and 'THREE' is
coded as '46'.
What is the code for 'BREAK' in the given code language?

A.  A. 27

B.  D. 24

C.  C. 21

D.  B. 29

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter-cluster.)6182

A.  A. CE-FH

B.  C. BE-DG

C.  D. KN-MP

D.  B. PS-RU
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Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).

Statements:
Some cows are plants.
All plants are mints.

Conclusions (I) : Some cows are mints.
Conclusions (II) : All mints are plants.

A.  A. Only conclusion (I) follows

B.  C. Only conclusion (II) follows

C.  D. Neither conclusion (I) nor (II) follows

D.  B. Both conclusions (I) and (II) follow

✓

Q100 Reasoning
Refer to the following series and answer the question. (All numbers
are single digit numbers only. Counting to be done from left to
right.)

(Left) 8 4 5 8 5 4 9 3 2 6 1 3 6 7 1 5 7 9 4 2 6 7 1 2 9 3 5 7 1 (Right)

How many such even digits are there each of the which is
immediately preceded by a perfect square and immediately followed
by an odd digit? (NOTE: 1 is also a perfect square.)

A.  A. More than three

B.  C. One

C.  D. Two

D.  B. Three
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